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Overview

SplashlD Enterprise is designed to quickly and effectively address the most immediate
password management concerns of IT. It allows an organization to use stronger
password management practices without compromising security or increasing costs.

SplashlD Enterprise provides a complete password management and security solution for
organizations using either Windows or Mac OS platforms for end users. SplashlD Enterprise offers IT
managers powerful control for the centralized administration of password and security policies across
various departments and employee groups throughout an enterprise.

Benefits of SplashlD Enterprise

* Increase employee productivity: SplashlD makes managing and accessing passwords easier
and more convenient, giving your employees more time to focus on important tasks. SplashlD
will decrease forgotten password requests, ridding IT of unnecessary distractions and allowing
focus on projects that create real value. In addition, the next update of SplashlD Enterprise will
optionally give your employees access to records on their smartphones, enabling them to be
moare productive out of the office as well.

¢ Decrease potential costs of security threats. As described earlier, the costs of data breaches
are astronomical. By implementing SplashlD, your organization significantly reduces the risk of
information stolen via password exposure, including data loss, legal costs, the loss of
customers, and the loss of employee productivity.

Features of SplashlD Enterprise

The major features of SplashlD Enterprise include:

¢ Cross-platform Windows, Mac, Web browsers and Maobile client end-user support

e Support of MySQL server on Windows, Mac, or Linux

¢ Centralized secure database of usernames, passwords, documents, and other records
¢ Administrative control panel for IT with user management

¢ (Customizable group-level and user-level permissions

¢ (Customizable deployment architecture

* Multi-layer database security

Implementation of SplashlD Enterprise Edition

SplashlD Enterprise offers a simple architecture that works with existing enterprise systems so that
SplashlD can be up and running on your employees’ computers in very little time, under an hour in
most cases.

There are three components that comprise the SplashlD Enterprise System:

* Web Server running MySQL (SplashID database] - SplashID Enterprise records are encrypted
and stored in a MySQL database server. MySQAL server can run on Windows, Linux or Mac.

¢ SplashlD Enterprise Admin application [used by the IT Administrator] - The SplashlD
Administrative Control Panel application requires root access to the MySQL server. The
Administrative Control Panel is used for User Management to create, edit, delete users and
assign permissions on the system. The Admin application can run on Windows or Mac.

¢ SplashlD Enterprise Client application (used by Employee) - Employees or IT installs the
SplashlD Enterprise client application (Windows, Mac, Web browsers and Mabile client). The IT
administrator provides employees with initial SplashlD Enterprise login credentials via an
automated system.
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SplashlD Enterprise Deployment
There are two ways to deploy SplashlD Enterprise:

Deployment Option 1: Self Hosted

If someone in your organization has experience setting up MySQL servers, you can easily host SplashlD
Enterprise either in your intranet or in the cloud. Detailed instructions can be found in the SplashiD
Enterprise Getting Started Guide. The setup will generally take less than one hour. If you prefer a self
hosted solution but do not have MySQL expertise in house, SplashData offers consulting services for
setting up a self hosted MySQAL server. To take advantage of these services, contact Arjun Thyagarajan
on SplashData’s enterprise team by email: arjun@splashdata.com.

With either self hosted solution, the steps to deploy SplashID Enterprise are simple:

Install MySQL server

Launch SplashID Enterprise Admin application

Connect Admin application to MySQL server with root access

Create users, assign permissions, and create groups as needed

Employees launch SplashID Enterprise client applications with login details provided by Admin

S

MySQL Server Inside Company Intranet

MySQL server needs to be installed on a system inside the company intranet. Admin and Clients can
access the server only while inside the company network or through VPN.

SplashID
Enterprise




MySQL Server in the Cloud

MySQL server needs to have a globally accessible hostname or IP address, which can be used by the
Admin and Client applications to establish connection.

Deployment Option 2: Hosted Solution

SplashData also offers a hosted version of SplashlD Enterprise. A hosted solution delivers the benefits
of fast and easy implementation, high security, and worry free management. If you are interested in a
hosted solution, please visit splashdata.com/enterprise or contact SplashData by email:
enterprise@splashdata.com




Download SplashlD-Enterprise.zip installation package from:
http:/ /www.splashdata.com/enterprise,/downloads/links.htm

Install MySQL Server

MySQAL server needs to be installed only if you have chosen-
Deployment Option 1: Self Hosted

Skip this step if you have chosen-
Deployment Option 2: Hosted Solution.
SplashData will install MySQAL and provide you with the login information

1) MySQL Server can be install on Windows, Mac or Linux.
Most Linux distributions comes with MySQL bundled.
Windows installer is included in SplashlD-Enterprise.zip

2] Set root password and allow Remote login connections

Install MySQL Server

PHP needs to be installed only if you have chosen-
Deployment Option 1: Self Hosted

Skip this step if you have chosen-
Deployment Option 2: Hosted Solution.
SplashData will install PHP and provide you with the information

PHPL can be install on Windows, Mac or Linux.
Windows installer is included in SplashlD-Enterprise.zip

Install SplashlD Enterprise Admin application

Windows and Mac application are included in SplashlD-Enterprise.zip

1) Run the installer.exe for Windows and Installer .dmg for Mac

2] Launch SplashlD Enterprise Admin application
Windows - (Start Menu > Programs -> SplashData > SplashlD Enterprise > SplashIlD
Enterprise Admin
Mac - Applications > Run SplashlD Enterprise Admin app

3) Enter login details of MySQL server



8.0 Welcome To SplashID Enterprise

Server IP/Hostname: | 76.191.100.77 Port: | 3306 [3]

MySQL Username: root

MySQL Password: eesees

SplashID Master Password:

Cancel ) ( Connect )

Server |IP Address - is the address of the system on which MySQL is running. Alternatively,
hostname of the server could also be entered.

Port - Port on which MySQAL is running on the system. Default port is 3306.

MySQAL Username - <root username>

MySQL password - <root password>

SplashID Master Password:: Keep it Blank on first launch, as it needs to be set

Set Master Password
Once the database is created, Set Master Password. This password is used to encrypt the

SplashID Enterprise database. Users on the system would need SplashID Enterprise Master
Password to access their account

Install Web Services

Webservices folder is included in SplashiD-Enterprise.zip
Place the ‘splashid’ folder in the root path of the web server
Test if the login screen can be accessed by entering the URL in the browser:

<server path>/splashid/webclient/login.php
Ex: http:/ /localhost/ splashid /webclient/login.php

Alternatively, you can deploy it securely over HTTPS as well.

Install Moblie Clients

Moblie-Clients folder is included in SplashID-Enterprise.zip

Android - install SplashlD-Enterprise.apk
BlackBerry - <instructions coming soon>
iPhone - <instructions coming soon>

Browsers on Smartphones and Tablets can access SplashID Enterprise web client by:

http:/ /<server path>/splashid /webclient/login.php
Ex: http:/ /localhost/ splashid /webclient/login.php



User Management

The User Management module contains options for-
* Create Users / Assign permissions

* Import / Export Users

¢ Set Password Policy

‘User Management’ button is at the top-center of SplashlD Enterprise Admin application.

(8)

Views  Options User Management Lock

0068 User Management

E a N Search: Qsearch

‘SplashiD Enterprise Account Set Passward Policy_Import Users  Export Users

Name Password | Description
P & New...
b - e @ New
. X Delete

Purchase Licenses
Purchase license from:

http:/ /www.splashdata.com/enterprise/purchase.htm

Set Password Policy

User Management

o -

ie Account Set Password Policy Import Users Export Users

Minimum Length: 6 @
Strength:
Character Set: M a-z ™ 0-9

(" Cancel :( oK )

Companywide Passwaord policy can be set, so that every user account created has a password in line
with the policy

Create Users / Assign permissions

New users can be created by selecting ‘New’ in the User Management module.



SplashiD knterprise - root

) @ oEw @ @) (&)

Views Options User Management Lock

—1 0086 User Management L

New...

i X Delete

[ /  Edit..
| Duplicate...

Name Password Description +
1 [ ter.. ]
& Done

Enter the details of the User-

. .
—Hoeﬂnfoﬂmﬁon—i User Permissions 1—

Login Information:

Username: steve

Set password: KCfh

Confirm password: KCfh
Group: | <Add more Groups> )

Additional Information;

Full Name: Steve

Description:  janardhan

Email: steve.j@wgi.com

Phone Number: | 3088030032 )

[} User cannot change password
"] Account disabled

¥ Send details to user via Email ( Cancel ) oK)




Select the Groups user has access to by selecting drop down ‘Add more Groups™

Add User
IGroup'Name B ' Access Permission ]
P Engg o
Finance O H
HR =]
5\
/
Ce
5
1)
Add i

_'Account disabled

(VI Send details to user via Email ( Cancel ) ( oK )
Assign permissions to the user-
b Add User
[ User Information |- User Permissions |
Group Permissions:
M Add Group [ Edit Group [ Delete Group
Type Permissons:
@Add Type @ Edit Type E Delete Type
Record Permissions:
@Add Record E Edit Record E Delete Record
Data Permissions:
] Print Data ¥ DeDupe Data (¥ Import Data
M Export Data [ Backup [V Restore
[ Select All
¥ Send details to user via Email ( cancel ) ok )

Import / Export Users



User Management

= w H &

SplashID Enterprise Account Set Password Policy Import Users Export Users

Users can be imported from a csv file.

Format of the csv is as follows-
Username, Password, Confirm Password, Full Name, Description, Email, Phone, Group-Permission,
Type-Permission, Record-Permission, Data-Permission

Sample csv available at-
http:/ /www.splashdata.com/enterprise/sample-import.csv

Exmaple-
> A B © D E [ F G H  E— — b K
1 |Username Password Confirm Passy Full Name Descriptior Emall Phone Group-Permiss Type-Permiss Record-Permi Data-Permission
2 |michael michael123 michaell23  Michael Jailson QA michael@wgi.com 831 390 2486 1 1 1 1
3 [chris chris123 chris123 Chris Kallis TSE chris@wgi.com 831 390 2489 1 1 0 0
4 |jong jong123 jong123 Justong Smith VP jongs@wgi.com 839 323 7732 1 1 1 1
5 |morrison morrison123 morrison123 Morrison Peterson CEO morri@wgi.com 831 390 2486 1 1 1 1
c

Permissions fields-

Group-Permission, Type-Permission, Record-Permission, Data-Permission
1 - User has permission

O - User does not have permission

Similarly, for backup purposes, users can be export to a csv with the same format as Import

Groups

Groups can be created for Departments or Groups within the company.

The idea is that Every Groups has a set of records inside it. A user assigned to Group X can view
records in Group X. Groups act as filters for grouping related records.

Groups can be created / edited from File -> Edit Groups

e

Edit Groups
U

¢ | Groups

Engg T TE—

Finance [ —

HR Edit...
| Personal-root
»

Delete

€ Duplicate...

Editing a Groups, allows assigning Users to the Groups-



Edit Groups

q Name : Engg

[ Add User | Merge Groups Set Permissions |

| Name Description Permission
# —
avery A | o |

( Cancel \:( OK )

Groups can be created on the Admin application or Client application (provided the employee has the
permission to create a Groups)

Types and Records

Types

Types act as templates, which define the structure for the items you want to store in SplashlD. You
may define up to 9 custom field labels and a default icon for each type, as well as specify the fields you
wish to mask. For example, you may create a type for Web Logins, which includes custom field labels
for username, password and URL, with a globe icon, and the password field masked; and you may
create a Type for Credit Cards which includes custom field labels for credit card number, expiration
date and PIN, with a Visa icon, and the credit card number and PIN masked.

e Edit Types - Select Edit Types from the type menu to display the Edit Types dialog. You may
create an unlimited number of Types. Several sample Types are provided, which you may edit
or delete. Select an existing type and click edit, or click New to create a new one. The Define
type dialog is displayed.

e Define Type - Enter a name for the Type and up to 9 custom field labels. The Mask checkbox
specifies whether or not the data in that field will be masked. And you may also specify a default
icon for the Type.

WA

Edit Types
J
Types
Access Codes Y Srvr—
Bank Accts m ‘L)
Calling Cards Edit...
Combinations
Combinations Delete
Contacts

Credit Cards
Dev Projects
Documents
Domains

Record
]
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Each record has the below fields. They can be edited from the Edit Record screen-

e Group — Record Group
e Type — Record Type
* Fields -- Enter your data according to the field labels.
* Custom Field Labels -- You may assign Custom Field Labels by clicking the Custom button.
e Masking -- A bullet appears to the right of any field that is masked. You may customize the field
masking by clicking the bullet or selecting Customize Field Labels from the Options Menu.
¢ Buttons --
o lIcon: opens the icon selector. New in version 5, you can add a custom icon to any
record.
o Attach File: Attach any file to the record for future reference. Attached files are saved in
a folder next to the database.
Password opens the Automatic Password Generator (below).

o
o Duplicate creates a copy of the record.
o Custom opens the Custom Field Label dialog.
o Delete deletes the current record, after confirming that is what you wish to do.
o OK exits the record, saving any changes.
o Cancel exits the record, discarding any changes.
OO0 Detail View
|
’ Group: | Engg 5 ‘ (&) ’
Type: | Web Logins s Attachment: |13
=) |
Description: Amazon Field 6: '
Username: johndoe Field 7: !
t
Password: mom67rib * Field 8:
URL: www.amazon.com *] Field 9: ‘
Field 5: Date Mod: May 07,2008
Notes:
Customer Service: 800-555-1212
o Password ‘ ’@ Custom ‘ ‘A Delete ’ ‘ Duplicate ‘ ‘g Print... | ‘; ") Cancel ’ ‘0 OK

Options / Preferences
[



Options dialog can be launched from Options button

w== @ (&) (&)

Views Options User Management Lock

\]‘

Options

e / oo
(3 L L

Security User Data Format Show Columns
M Clear Clipboard O At Exit @© Adter 30[%] Minutes

[ Run SplashID on startup

[] Auto-Submit Web Logins

# Auto lock the application if inactive for ' 10 Minutes.

(" Cancel \1( OK ) '

Following items can be set using Options dialog-

Security - Security options such as Clear clipboard, auto-lock, etc
User Data - User Event logging

Format - Font selection

Show Columns - Columns to be displayed in List view

Import, Export and Backup

You can share information with other SplashlD Desktop users by exporting and importing your
SplashID records. Records can be exported/imported on the desktop in several formats:

SplashID vID - You may import and export SplashlD records in SplashID Virtual ID (vID) format, which
allows you to export and import records in a secure, encrypted format. vID files may be encrypted by
assigning a password when exporting. The recipient of the vID file may import the data into their copy
of SplashID Desktop by double-clicking the file, or choosing Import/SplashiD vID from the File Menu. If a
password was assigned to the file, the recipient must enter the password in order to import the data.

CSV - Records can also be imported and exported as CSV, but vID is a more secure way of doing it.
Backup-
SplashlD Entrprise database can be backup by File - Export > vID (Backup All Records)

Alternatively, MySQL database can also be backed up, which contains SplashID Enterprise records.

To Import the vID, File = Import -> vID.
Similarly, MySQAL backup can also be resoted

FAQs and Support

How do | get support?
http:/ /www.splashdata.com/enterprise/support.htm



How secure is SplashlD Enterprise?
SplashlD Enterprise allows you to securely store company data. Data is encrypted, protected, and
locked on a central database, and only users that have access to the system can read or edit data.

Key Security Features of SplashlD Enterprise

256-bit Blowfish and AES encryption - Your SplashlD data goes through two rounds of
encryption - 256-bit AES and 256-bit Blowfish. The password is also encrypted within the
MySQL database. SplashlD Enterprise uses approved Blowfish and AES libraries for all of its
encryption and key generation. SplashID Enterprise is also compliant with FIPS 140-1 and FIPS
140-2.

Secure communication - Client-server communication of SplashlD data occurs only when the
data is in an encrypted state. Communication is directly over TCP/IP, where |IPsec provides an
additional layer of security.

Secure MySQL database - MySQL itself encrypts the data using the in-built MySQAL encryption
methods. Only the SplashlD Enterprise Admin with root access can log in to the database. If
the database is running locally or within the company network, TCP networking can be disabled
for remote access.

User Permissions - While creating users, the SplashlD Enterprise Admin applies access
control settings for each user. The Admin assigns Group and record based permissions, and
so each employee's access depends on the permissions granted by the Admin.

Secure Backups - SplashlD Enterprise Admin can backup the company's SplashlD data to a
secure password protected SplashlID vID file. Also, the entire MySQL database can be backed
up, and that backup is also encrypted.

Timeout - SplashID will automatically lock and hide the data after a specified period of time, so
the Admin or employee doesn't need to remember to logout of SplashlD when leaving a desk.

Strong Password Generator - Admin and users can use the customizable Password
Generator in SplashID to create passwords that are complex and unguessable.

Can SplashID Enterprise be used to store attachments securely?
Yes, attachments in records are encrypted and stored securely in the SplashlD Enterprise database.

How much do SplashID Enterprise licenses cost?
http:/ /www.splashdata.com/enterprise/ pricing.htm



